
Tax Crew Organizer 
This organizer is designed to help you collect and report the 
information needed to prepare your tax return. Please enter your 
information in the worksheets that apply to you. Returning clients:  
You can leave blank sections that haven't changed from your 
previous tax return (e.g. address, SSN, birth date, phone, 
dependents). If information has changed from the prior year, enter 
complete information in that section of the organizer.

To complete the organizer electronically, download a copy to your device first 
so your entries will be saved. Use the method that is the most convenient for 
you to submit your completed organizer and documents:  

 Upload to our SmartVault client portal. This is the most secure
method to submit your documents. If you don't have a portal
login yet, just send an email request to info@mytaxcrew.com

 Mail or ship to Tax Crew 10 Santa Clara San Clemente CA 92672
 Fax to 949.309.2902
 Email to info@mytaxcrew.com

        THANK YOU FOR CHOOSING TAX CREW  
New clients: Who referred you to Tax Crew? 

Tax Crew  10 Santa Clara   San Clemente CA 92672

info@mytaxcrew.com 
www.mytaxcrew.com    Phone/Text 949.234.0095 

Please send us copies of any of the following documents that you received 

☐ All W-2’s. (Your company may issue more than one) ☐ K-1s for Partnership, S-Corps, or Trusts

☐ 1099 R Retirement Account Distributions ☐ Statements or Forms You Have Questions About

☐ 1095 A for ACA Marketplace Health Insurance Plans ☐ Voided Check for Direct Deposit if New Account

☐ 1098 Mortgage Interest Paid ☐ New Clients: Copy of Last Year’s Federal & State Tax Returns

☐ Property Taxes Paid (if not reported on your 1098) ☐ Flight data

☐ 1099 DIV Dividend Income ☐ Local Tax Forms & Instructions If You Want Us to Prepare

☐ 1099 INT Interest Income ☐ Payment (credit card information or check)

☐ 1099 B for Security Sales (stocks, mutual funds, etc.) ☐ Completed Organizer & Signature Below

Please sign below 
We will prepare your federal income tax return and any state and local returns you may require from the information that you provide. You agree to 
provide us with all income and deductible expense information necessary to prepare your return, and any changes to your contact (e.g., new address, 
phone, email, etc.) or banking information. In preparing your return(s), we will not audit or verify the data you submit although we may ask for 
clarification. We will use our judgment in resolving questions where the tax law is unclear or where there may be different interpretations of the law.  

It is important that you review the return carefully before signing to make sure the information is correct. Unless otherwise stated, the services for 
preparation of your return do not include auditing, review, or any other verification or assurance. Full payment of your tax preparation fee is required 
before we will electronically file your return or release a copy of the return. 

Deadlines & Extension requests:  We process tax returns in the order that we receive organizers. The volume of organizers we receive increases 
significantly during the three weeks before the filing deadline. To guarantee completion of your return by the due date, please provide your tax organizer 
and documents to us by March 23.  For tax information received after March 23, we will make every effort to complete your return by April 15, but will 
file an extension request if necessary.  

Please email us (info@mytaxcrew.com) before April 1 if you have not submitted a tax organizer but need to file an extension request. Even with a filing 
extension, the IRS and states will charge penalties and interest if you have paid less than 100% of your current tax liability by April 15. IRS and states do 
not accept extension requests after April 15.  

This engagement letter will apply for all future years unless the agreement is terminated or amended in writing by you or us. We appreciate the 
opportunity to prepare your tax return.  

 __________________________________      ______________       _________________________________       ________________ 
       Taxpayer Signature    Date     Spouse Signature          Date 

Privacy Policy 
The privacy of your client information is always important to us, and we adhere to professional standards of confidentiality. We collect nonpublic personal information about you that is provided 
by you or obtained by us with your authorization. This information may come from various sources, including information we receive from personal interviews, tax organizers, worksheets and 
other documents necessary to provide professional services to you. We do not disclose any nonpublic personal information about our clients or former clients, except as permitted or required by 
law, or when necessary to process transactions requested by you. We restrict access to nonpublic personal information about you to members of our firm who need to know that information in 
order to provide you professional services. We retain records relating to the professional services that we provide you in accordance with accounting and government standards. We employ 
physical, electronic and procedural safeguards to protect your nonpublic personal information.

Save time with these tips:
 Only complete sections that apply to you
 If you're sending us a tax document, you don't have to

duplicate the information on the organizer
 To send documents digitally, scan to a single PDF file. You

can use Apple Notes or a free PDF App like Camscanner



 Individual Tax Organizer

Personal Information

You:

First name Last name Social Security Number

Date of Birth Occupation

Phone Number Email Address

Marital Status: Single Married Divorced Legally separated Widowed

Spouse:

First name Last name Social Security Number

Date of Birth Occupation

Phone Number Email Address

Mailing Address:

Address City State Zip code

Did your address change? Yes No Date changed

Dependents

Dependent 1:

First name Last name Social Security Number

Date of Birth Relationship

Income (if over $4,400) Number of Months Resided in Home

Was a full-time college student? Yes No Filed their own return? Yes No

Dependent 2:

First name Last name Social Security Number

Date of Birth Relationship

Income (if over $4,400) Number of Months Resided in Home

Was a full-time college student? Yes No Filed their own return? Yes No

Dependent 3:

First name Last name Social Security Number

Date of Birth Relationship

Income (if over $4,400) Number of Months Resided in Home

Was a full-time college student? Yes No Filed their own return? Yes No

Dependent 4:

First name Last name Social Security Number

Date of Birth Relationship

Income (if over $4,400) Number of Months Resided in Home

Was a full-time college student? Yes No Filed their own return? Yes No



Income Sources - provide any tax forms (W-2s, 1099s) received

Work Income

Had a Job (W-2)

Self-Employed (1099-NEC, 1099-MISC, 1099-K)

Investment & Savings 
Brokerage Accounts (1099-B, 1099 Consolidated)

Interest Income (1099-INT) - no statement issued if total interest is less than $10

Dividend Income (1099-DIV)

Exercised Incentive Stock Options (Form 3921)

Sold Real Estate (1099-S)

Less Common Investment & Savings

Received 1099-OID

Undistributed Capital Gains (Form 2439)

Foreign Accounts - see Foreign Accounts Worksheet on page 10

Retirement Plans and Social Security

IRA, 401k, Pension Plan Withdrawals (1099-R)

Amount transferred to charity - QCD

Social Security Benefits (SSA-1099)

Rentals, Royalties, and Farm

Rental Properties & Royalties (1099-MISC)

Farm Income & Rental

Other Income

Unemployment & Government Payments (1099-G)

Received K-1

HSA/MSA Withdrawal (1099-SA)

Gambling Winnings (W-2G)

Amount not reported on W-2G

Received Alimony

Amount of Alimony Date of Divorce or Separation

Jury Duty

Amount Received Amount Repaid to Employer

Sold Main Home (gain or loss)

Date Purchased Purchase Amount Other Expenses

Home Foreclosure or Debt Cancellation (1099-A, 1099-C)

529 Plan or Coverdell ESA Withdrawal (1099-Q)

Other

Amount received



Deductions and Credits

Home

Home Loan Interest (Form 1098)

Property Taxes

Main Home Additional Homes

Family

Child Care Credit

1. Child's Name Daycare Name

Daycare Provider SSN/EIN Daycare Address

Total Amount Paid

2. Child's Name Daycare Name

Daycare Provider SSN/EIN Daycare Address

Total Amount Paid

3. Child's Name Daycare Name

Daycare Provider SSN/EIN Daycare Address

Total Amount Paid

Adoption Credit

Child's Name Birth Year

SSN, ATIN, or ITIN Adoption Expenses

Does child have special needs? Yes No Is child a U.S. citizen? Yes No

Paid Alimony

Recipient's Name Recipient's SSN

Alimony Amount Date of Divorce/Separation

Charitable Donations

Cash/Check Donations

Total Amount Donated

Non-Cash Donations

1. Organization Name Organization Address

Description Date of Contribution

Donation Value Cost Basis Date Acquired

2. Organization Name Organization Address

Description Date of Contribution

Donation Value Cost Basis Date Acquired

Retirement

Retirement Contributions

Traditional IRA Amount converted to Roth IRA

Roth IRA

SEP

Solo 401(k)



Deductions and Credits (continued)

Education and Work

College Tuition & Expenses (1098-T)

Cost of Supplies (purchased at school) Cost of Supplies (purchased elsewhere)

Did you receive financial aid not reported on a 1098-T? Yes No

Student Loan Interest (1098-E)

Educator Expenses

Amount Spent

Vehicles & Personal Property

Major Purchases

1. Description Sales Tax Paid

2. Description Sales Tax Paid

Car Registration Fees

1. Make & Model Amount

2. Make & Model Amount

Casualties and Thefts

Description of Event Date

Property Lost or Damaged Cost

Energy Efficiency Credits

Home Energy Credits

Exterior Doors Exterior Windows Metal/Asphalt Roof

Insulation Building Property Furnace Fan

Furnace/Water Boiler Solar Heating Wind Energy Property

Heat Pump Fuel Cell Property Fuel Cell Capacity

Energy Efficient Vehicles

Make Model Year

VIN Date Purchased Credit Amount

Energy Efficient Charging Station

Cost

Medical

Contributions to HSA/MSA (Form 5498-SA)

Amount

Medical & Dental Expenses

Medical Professionals Prescription Drugs Labs and X-rays

Medical Facilities Medical Supplies Glasses & Contacts

Medical & Dental Ins. LTC Ins. (You) LTC Ins. (Spouse)

Travel Expenses No. of Miles Traveled Other

Affordable Care Act (1095-A)



Airline Crew – residents of AL AR CA HI MN NY PA 

Layover transportation (van driver tips, cabs, rental cars, Lyft/Uber)          

Union and professional organization dues 

Work related publications/education 

Uniform/luggage purchase, cleaning, repair, alterations 

Work equipment/supplies 

Business phone & internet (50%-75% of monthly base fee X 12 months) 

Mileage between home & co-terminals. Commuting expenses to/from primary work location are not deductible.  

Temporary assignment/monthly base swaps/out of base pickups/initial, upgrade and recurrent training: 

Number of days at TDY, temp base, training Out of pocket lodging/utility costs 

City code of temporary/training location Personal car miles driven to/from/at temp location 

Out of pocket (non-reimbursed) transportation costs Other unreimbursed expenses 

FLIGHT DATA  
To calculate your per diem deduction, please send us the following in a digital file (no printouts). Attach your downloaded file (per instructions below) 
to an email message and forward to info@godiem.com. Include your name & mention that you’re a Tax Crew client.   

American Airlines  
Flight Attendants: On JetNet, navigate to Departments > Flight Service >Tools > Crew Sequence History  
1. On the portal page, select Links > Crew Sequence History. Select the Contract Year >  All Contract Months. Click Retrieve.
2. From the Reports menu, select Comma Separated Values (.csv). You     r Sequence History will download to your device.  

Pilots: Login to the APA website (www.alliedpilots.org). On the homepage, select the Committees link.  
1. Select Scheduling > Sabre Application link. Log in and from the top right of the DECS page, select Go To > Log Book .
2. Click the link ‘Use the Group Tree to drill into . . .’ to open filtering options. In the drop-down, enter the date range that you’d like to export.
Click the ‘Filter & Hide’ button. You’ll see the filtered file listed under ‘Group Tree’. Click the icon to download the file.
3. Select Microsoft Excel (97-2003) in the ‘File Format’ drop-down and the ‘All Pages’ radio button. Click the ‘Export’ button.

Delta Air Lines  
Flight Attendants: Sign into iCrew and from the ‘Schedules’ drop-down, select ‘F/A Preference’. On the next page, click on ‘Schedule Leg Data 
Extract’. You’ll see two options. Choose the second option: ‘email Schedule Leg Data to your company account. Enter ‘YES’ for this (second) 
option and click the ‘OK’ button. You’ll receive the confirmation message ‘Email request submitted’. Log in to your company email. You’ll receive 
an email with your ‘Schedule Leg Data’ attached. Forward the email you receive directly to info@godiem.com (do not download to your device).  

Pilots: On DeltaNet select ’Self Service’ from ’My Links’. On the Self Service page, select ‘My Money’. Select ’Pilot Activity Statements (PAS). On 
the PAS page, select the tax year you want to extract and ’All’ for the month. Click the ’Retrieve’ button. Click the checkbox next to ’Pay Period’ 
to select all the months for the year. Click the ‘Export’ button. This will create a Zip file that you can save to your desktop.  

United Airlines  
Flying Together > Tools and Resources > My Info/Manager's Toolbox > Per Diem >Per Diem Letter. Send us a copy of the Per Diem Letter with your tax 
documents or upload to your SmartVault.  

All Other Airlines  
Copy and paste your flight information to our Flight Data Submission Form and submit the form electronically to info@godiem.com. You’ll find a copy of 
the form, with instructions, in the Public Documents folder in your SmartVault portal or on the Tax Center link at www.mytaxcrew.com   

Alaska Airlines  
Flight Attendants: Pay Detail Reports (make sure to include page 2 if applicable)  
Pilots: Time sheets (make sure to include page 2 if applicable)  

FedEx Flight data is in your Trip Recap (or Trip Summary). Navigate to your VIPS Trips Recaps. Select calendar option and click the link for each trip..  

Hawaiian Airlines CrewTrac > Options > Schedule Detail > Select months from dropdown and ‘Hide Drops’ from Print Options. On the next screen select 
“Show Printer Friendly Version”.  

JetBlue Rainmaker > Crew Pay Report. Select Bid Period and Detail for the trips you flew.   

Net Jets Provide the Crew Member Duty Report CRC Online > Crew My Pages. 

SkyWest SKEDPLUS > Options> Crew Time Report. Enter date range (make sure to include any year end carry-in or carry- out trips).  

Southwest  
Flight Attendants: ( Do not use the Flight Data Submission Form) Monthly Payroll Reports. Contact your payroll depart-ment and ask them to 
email you the reports in .doc or .rtf format. Forward the email to info@godiem.com. Include your name and ‘Tax Crew client’ in the subject line.  
Pilots: (Do not use the Flight Data Submission Form) SWAPA > My Stuff > Logbook Export > select Tax Year > select XLS to export > save file to 
your computer. Email the file to info@godiem.com. Include your name and ‘Tax Crew client’ in the subject line.  
UPS: Flight Ops > Fligh Payroll Registers. Make sure you include trips for the entire calendar year.  

UPS Pairing Detail Report from FlightOps > CrewApp > SchedView. 



Self Employment/Small Business Worksheet

Work Description

Type of Work Business Name

Income

1099-NEC

1099-MISC

1099-K

Cash and Checks Amount Earned in Cash and Checks

Expenses

Advertising Commissions and Fees

Business Insurance Interest - Mortgage

Interest - Other Legal & Professional Fees

Office Expenses Rent - Vehicles, Equipment, etc.

Rent - Business Property Repairs & Maintenance

Supplies Taxes & Licenses

Business Travel Business Meals

Utilities Inventory

Bank Charges Dues & Subscriptions

Telephone Miscellaneous

Labor:

Contract Labor Expenses Did you pay any contractor $600+? Yes No

Did you have any employees? Yes No Wages Paid

Vehicle:

Make & Model Date Purchased/Leased

Miles Driven (work and personal) Miles Driven (work only)

Parking & Toll Expenses Other Vehicle Expenses

Depreciable Assets:

1. Description Date Purchased Cost

2. Description Date Purchased Cost

Home Office:

Square Footage of Home Office Square Footage of Entire Home

Other Expenses:

1. Description Cost

2. Description Cost

3. Description Cost



Property 1  Property 2   Property 3  Property 4 

Property address 
    City, state, Zip 
Type of Property 
(single family, multi-family, land, 
commercial, short term) 

During the tax year # of: 
   days available for rent/rented 

days of personal use 

 Percentage ownership

  Percentage rental use 

  Qualified trade or business 
  under Section 199A? * 

Rents received 
Expenses 

  Advertising 
Travel  
Cleaning / Maintenance 
Commissions 
Insurance 
Legal/Professional Fees 
Management Fees  
Mortgage Interest 
Repairs 
Supplies 
Real Estate Tax 
Other taxes 
Utilities 
Other: 

 Capital improvements, remodels, assets placed in service during the tax year 
 Description In-service date Cost Property 1,2,34 

Sale of Rental Property - If you sold a rental property during the tax year, please send us copies of the Closing Disclosure (Settlement 
Statement) from both the purchase and the sale of the property. 
Vehicle Expense 
Vehicle make & model Date first placed in service 
Total miles driven for the year Do you have evidence to support the deduction? Yes  No 
Total miles driven for all rental 
property business 

Is the evidence written? Yes  No 

*Section 199A Qualified Trade of Business

For purposes of the 199A deduction (20% of qualified business income), an enterprise is a trade or business if it qualifies as such under Internal Revenue 
Code Section 162. The section doesn’t expressly define “trade or business”, rather it’s determined on a case-by-case basis based on various factors. 
Generally, a qualifying enterprise is an activity conducted “on a regular, continuous and substantial basis” with the aim of earning a profit. 

Because of ambiguity on whether rental property qualifies under Section 199A, the IRS issued Revenue Procedure 2019-38 to establish a safe harbor. Under 
the revenue procedure, a rental real estate enterprise (RREE) is deemed a trade or business if the taxpayer (you or a “relevant pass-through entity” in which 
you own an interest): 

• Maintains separate books and records for the enterprise;
• Performs at least 250 hours of rental services per year (for an enterprise that’s at least four years old, this requirement is satisfied if you meet the

250-hour test in at least three of the last five years);
• Keeps logs, time reports or other contemporaneous records detailing the services performed; and,
• Files a statement with his or her tax return.

Revenue Procedure 2019-38 lists the types of services that count toward the 250-hour minimum. It also clarifies that they may be performed by the owner or 
by employees or contractors. Generally, taxpayers must either treat each rental property as a separate enterprise or treat all similar properties as a single 
enterprise. Commercial and residential properties, for example, can’t be combined in the same enterprise. 

Rental Property Worksheet



Foreign Accounts Worksheet - required if total assets in non-U.S. accounts exceeds $10,000 

Account #1:

Name of Foreign Bank Address

Account Type Account Number

Date Account Opened (if in 2023) Date Account Closed (if in 2023)

Maximum Value (Include Currency) End Year Balance (Include Currency)

Is the account owned jointly? Yes No

Account #2:

Name of Foreign Bank Address

Account Type Account Number

Date Account Opened (if in 2023) Date Account Closed (if in 2023)

Maximum Value (Include Currency) End Year Balance (Include Currency)

Is the account owned jointly? Yes No

Account #3:

Name of Foreign Bank Address

Account Type Account Number

Date Account Opened (if in 2023) Date Account Closed (if in 2023)

Maximum Value (Include Currency) End Year Balance (Include Currency)

Is the account owned jointly? Yes No

Account #4:

Name of Foreign Bank Address

Account Type Account Number

Date Account Opened (if in 2023) Date Account Closed (if in 2023)

Maximum Value (Include Currency) End Year Balance (Include Currency)

Is the account owned jointly? Yes No

Account #5:

Name of Foreign Bank Address

Account Type Account Number

Date Account Opened (if in 2023) Date Account Closed (if in 2023)

Maximum Value (Include Currency) End Year Balance (Include Currency)

Is the account owned jointly? Yes No



Additional Questions

Estimated Taxes Paid:

1st Quarter       (Apr) 

2nd Quarter     (Jun) 

3rd Quarter      (Sep) 

4th Quarter       (Jan)

Federal Taxes State Taxes Local Taxes

Direct Deposit & Electronic Payment:

If you're entitled to a refund, would you like to receive it as a direct deposit? Yes No

Bank Name Account Type

Routing Number Account Number

Notes Relating to Income Received:

Other Questions or Concerns:

If you owe on your tax return, would you like IRS (and state) to direct debit payment(s)? Yes No



Education Credits for K-12th Grade 
 You may claim a credit on your state return in these states for the following qualified expenses: 

AZ- Fees and donations to a public or charter school located in Arizona for extracurricular or character education programs. 
IL – Tuition, fees, book rental, band and lab equipment rental fees paid directly to private, public or religious schools. 
IA – Tuition and textbook costs paid to an Iowa accredited not-for-profit school. Certain extracurricular program expenses qualify, such as activity fees, club dues, and school 
sports fees. 
IN – Fees for non-public private, parochial or home school for grades K-12. 
LA – Cost of tuition, fees, books, materials, supplies and school uniforms. 
MN – Tuition and fees paid to private or public schools. Also costs of education supplies including up to $400 towards the purchase of a home computer and educational 
software. 
WI – Fees for tuition and textbooks paid to a private school, excluding amounts paid with a voucher. 
Student’s Name & Grade Expenses School Name & Address 

Education Savings Accounts 

Type of account (Coverdell, 529, pre-paid tuition) Name (for state plans) Account number Beneficiary Amount 

Renter’s Credits for Residents of CA IN MA MN NJ NY WI 
CA Check here      if you paid rent on a California residence 
MN & WI Send us your Certificate of Rent Paid or Rental Certificate 
MA, NJ, NY Enter total amount of rent you paid 
IN Landlord’s name phone number 

Landlord’s address 

Total monthly rent # months rented Your share of 
monthly rent 

 State Credits and Deductions 
AZ Credit for contributions to Qualifying Charitable Organizations or to Qualifying Foster Care Charitable Organizations. Include the name/address of 

organization(s) and amount of contribution(s).  

CT 

State property tax credit (maximum $300 credit) 

Property CT Tax Town/District Address or Year/Make/Model Date Paid Amount 

Home 

Auto 1/Auto 2  / /  / 

DE Clothing and expenses incurred for service as an active volunteer firefighter 

GA Amount spent on home care services for persons over 62 

HI 
Cost of child restraint system – include copy of purchase receipt 

Renewable Energy Technologies Credit – include purchase information 

ID  Cost of insulation purchased last year and installed in primary residence 

IL  Homeowners: please provide PIN (Property Index Number) from your property tax statement 

LA  Please include a copy of the insurance statement showing the charges for LA Citizens assessments not previously claimed 

MA Please provide Form 1099-HC. The information on this form is needed to avoid a tax penalty 

 Qualified commuter expenses paid for public transportation (MBTA transit/rail, tolls paid through FastLane account) 

MI  Homeowners: Please provide the property tax statement showing the Taxable Value of Homestead, or enter the value here: 

MN  Please send us your Certificate of Rent Paid (renters) or Statement of Property Taxes Payable (homeowners) for THIS year 

MT  First Time Homebuyers Savings Account contributions 

NH  If you earned interest and/or dividends of more than $2,400, NH requires that you file a state investment income return 

OH  Job training expenses incurred during 12-month period after job furlough 



 Pricing Information & Payment Method 
 All preparation fees must be paid prior to filing return and releasing copies 

Federal Return $175 

Married filing jointly (add) – we’ll calculate whether MFJ or MFS is more beneficial for you $30 

First State Return $40 

Additional State Returns (part-year resident, non-resident returns) $40 

Crew Deductions and Per Diem Report (add if you’re a resident of AL, AR, CA, HI, MN, NY, PA and claiming work/crew/per diem deductions) $40 

Dependent Tax Returns - children under age 19, or under age 24 and a college student, with earned income (e.g. W-2 or 1099-MISC income) $50 

 Local return (for city/local returns) $50  Health Coverage Exemptions 8965 $30 

 Alternative Motor Vehicle Credit 8910 $40  Health Insurance Premium Tax Credit 8962 $40 

 Business use of home 8829 $30  Household employee taxes H $40 

 Cancelled Debt Exclusion from Income 982 $50  Injured spouse/Innocent spouse 8379 $40 

 Charitable non-cash contributions over $500 8283 $40  Installment Gain 6252 $60 

 Childcare credit 2441 $40  Interest income (no charge for first 4 1099s) $5/1099 

 Child’s investment income (kiddie tax) 8615 $50  Investment interest expense 4952 $30 

 Child Tax Credit & Advance Child Tax Credit Calculation 8812 $40  Non-deductible IRA 8606 $30 

 Depreciation Report $10/asset  Parents reporting child’s income 8814 $50 

 Dividend income (per 1099 or security if listed separately)     $5  Partnership/S-Corp/Estate (per schedule) K-1 $40 

 Earned Income Credit EIC $40  Passive activity loss limitations 8582 $40 

 Education credit 8863 $40  Rental Property (per property) E $60 

 Farm Income F $70-120  Residential Energy Credit 5695 $30 

 Foreign Bank Report FINCEN 114 for 1st 3 accounts. 
 $10/additional account $30 

 Sale of business assets 4797 $60 

 Sec 1256 Contracts and Straddles 6781 $40 

 Foreign earned income exclusion 2555 $70  Self-employed/small business C  $80-150 
 Foreign Financial Assets for 1st 3 accounts.  $10/add acct 8938 $30  Stock/bond sales (first 5 sales) $3/each additional sale D $50 

 Gambling income (per W-2G) $5/W-2G  Retirement account distributions/rollovers $30 

 Amended Tax Returns 1040 $150 Paper filing copy of tax return (if you opt not to e-file, 
or for tax years no longer accepted electronically) $30 

Tax Planning/Consultations $240 per hour, billed in 15-minute increments 

Go paperless!    -$10 

Protection Plus Audit Insurance - Program details are available in the SmartVault Public Documents folder $25 

Total
Most forms and fees are listed above. Additional fees may apply if other forms or additional work are required to complete your tax return. 

Corporate/Partnership/Trust/Estate Returns: Pricing varies depending on the complexity of the return.  

Audit Representation: Audit representation fees begin at $150 for basic correspondence audits or phone calls to IRS and state tax 
agencies. Fees increase depending on the type and complexity of the audit. Office and field audit costs average $1,900. Protection Plus 
Audit Insurance covers all audit representation costs if the IRS or a state tax agency audits your return.  

 Payment Method 
Check or Money Order Make payable to Tax Crew. ($25 charge for returned checks)

 Credit/Debit Card. (AMEX, Visa, MasterCard, Discover)

  Card Number   Expiration Date    Security Code  

  SignatureCardholder Name  (if different than taxpayer)

Save $10 off your preparation fees with our no mail/no paper option. We'll upload a copy of your tax return and documents to 
your SmartVault. We won't return anything by USPS. We recommend sending us copies of documents if you choose this option. 
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